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Legal information 
Warning notice system 

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent 
damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert 
symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are 
graded according to the degree of danger. 

 DANGER 
indicates that death or severe personal injury will result if proper precautions are not taken. 

 

 WARNING 
indicates that death or severe personal injury may result if proper precautions are not taken. 

 

 CAUTION 
indicates that minor personal injury can result if proper precautions are not taken. 

 

 NOTICE 
indicates that property damage can result if proper precautions are not taken. 

If more than one degree of danger is present, the warning notice representing the highest degree of danger will 
be used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to 
property damage. 

Qualified Personnel 
The product/system described in this documentation may be operated only by personnel qualified for the specific 
task in accordance with the relevant documentation, in particular its warning notices and safety instructions. 
Qualified personnel are those who, based on their training and experience, are capable of identifying risks and 
avoiding potential hazards when working with these products/systems. 

Proper use of Siemens products 
Note the following: 

 WARNING 
Siemens products may only be used for the applications described in the catalog and in the relevant technical 
documentation. If products and components from other manufacturers are used, these must be recommended 
or approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and 
maintenance are required to ensure that the products operate safely and without any problems. The permissible 
ambient conditions must be complied with. The information in the relevant documentation must be observed. 

Trademarks 
All names identified by ® are registered trademarks of Siemens AG. The remaining trademarks in this publication 
may be trademarks whose use by third parties for their own purposes could violate the rights of the owner. 

Disclaimer of Liability 
We have reviewed the contents of this publication to ensure consistency with the hardware and software 
described. Since variance cannot be precluded entirely, we cannot guarantee full consistency. However, the 
information in this publication is reviewed regularly and any necessary corrections are included in subsequent 
editions. 
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 Introduction 1 
1.1 What is the SITRANS CONNECTION App? 

SITRANS CONNECTION is an Apple App Store distributed terminal application for Apple 
iPhones and iPads that allows users of Siemens SITRANS F-US clamp-on flowmeters to 
connect to, and control their meter’s RS-232 serial ports to communicate directly with the 
flowmeter menu without the need for cellular service. The user can also establish terminal 
sessions over WIFI and 3G. 

  
With the SITRANS CONNECTION App, you can perform programming, maintenance, data 
gathering, and troubleshooting operations directly on your SITRANS F clamp-on flowmeter 
and you can achieve remote connection over Wifi/3G for technical support assistance! 
 

The SITRANS CONNECTION App has many features including: 

● Physical serial access to all SITRANS clamp-on flowmeters with your iPhone or iPad via 
the C2-RJ45V cable and DB-9 dongle (use of a C2-Lightning adaptor required for iPhone 
5) 

● Programmable serial configuration supports 300-57600 baud (38400 typical setting for 
SITRANS communication) selectable parity, selectable flow-control, variable stop bits and 
either 7 or 8 data bits 

● SSHv2, Telnet, and RAW connectivity over WIFI/3G 

● VT100, xterm and many other common Terminal emulations 

● Encoding support for ASCII, UTF-8 and 17 other major encoding formats, including multi-
byte characters for non-Latin text terminals 

● One Tap Secure Session Sharing allows a remote Siemens technical support engineer to 
view and interact with the iPad/iPhones terminal window 

● Tight integration with iPhone/iPad clipboard and cut/copy/paste directly from the terminal 
window 

● Comprehensive logging support, Command Shortcuts, Stored Passwords, Bluetooth 
Keyboard and many other features. 
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1.2 SITRANS CONNECTION App Requirement 
● iPhone3 + (iOS version 5.1 or later is required) 

● iPad1 onwards 

● C2-RJ45V serial cable 

● RJ45-DB9 dongle (SITRANS meters without DB-9 connector will also require a standard 
serial cable) 

● Wifi/3G connection for sharing session 

1.3 Connecting to SITRANS F US Serial Port 
Siemens SITRANS clamp on flowmeters utilize several different configurations for their RS-
232 port connectivity. Some have DB9 connectors while others have hard-wired or 
specialized connections. Therefore; while all connections will utilize the C2-RJ45V cable with 
an RJ45-DB9 dongle; depending on your specific meter type you will need to select one of 2 
dongles and possibly an interconnection cable. Siemens offers the standard SITRANS 
CONNECTION kit (P/N A5E32299674) which includes the C2-RJ45V cable and both a “Null 
Modem” dongle (Brown) and a “Standard” dongle (Black); plus a gender changer), this kit 
provides the basics for connection with any of clamp-on meters. Since not all of our meters 
are equipped with a DB9 serial port Siemens offers 2 additional connection kits to connect 
with those that don’t. The table below illustrates each meter variant, its serial port type, and 
the connection kit. 
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Table 1- 1 Connectivity Requirements 

Meter Type Serial Port Dongle Type Connection Kit 
FUP1010 (IP67) Amphenol Standard (Black) A5E32299677 
FUE1010 (IP65) Wire Terminal Standard (Black) A5E32299675 
FUE1010 (IP65) with 
extended Io option1) 

DB9 Null-Modem (Brown) A5E32299674 

FUE1010 (IP40 
portable) 

DB9 Null-Modem (Brown) A5E32299674 

FUG1010 all types Wire Terminal Standard (Black) A5E32299675 
FUG1010 (Not compact-
X) with extended Io 
option2,4 

DB9 Null-Modem (Brown) A5E32299674 

FUH1010 all types Wire Terminal Standard (Black) A5E32299675 
FUH1010 with extended 
Io option3,4 

DB9 Null-Modem (Brown) A5E32299674 

FUS1010 all types Wire Terminal Standard (Black) A5E32299675 
FUS1010 with extended 
Io option1,4 

DB9 Null-Modem (Brown) A5E32299674 

FUT1010 all types DB9 Null-Modem (Brown) A5E32299674 
FST020 DB9 Null-Modem (Brown) A5E32299674 
 Notes 

1. FUS/FUE1010 Extended Io option indicated by “J1B” adder in meter part number 
2. FUG1010 Extended Io option indicated by “B” code in 9th digit of meter part number 
3. FUH1010 Extended Io option indicated by “C” code in 9th digit of meter part number 
4. Extended Io option not available on IP65 compact meters 

In addition to the connection kit the SITRANS CONNECTION App P/N A5E33299678 can be 
purchased from Siemens or downloaded from the iTunes App Store. 
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1.4 Terminal Overview 
The picture illustrates the main SITRANS CONNECTION window (for iPhone) and identifies 
the major user interface features. 

 
① Data Transfer Indicator ⑤ Tools menu icon 
② Main Settings icon ⑥ Keypad on/Off/Dim icon 

1. Full screen (no keypad) 
2. Keypad in foreground 
3. Keypad in background 

③ Connection Manager ⑦ Special Function Key 
④ Keypad Selector: 3 States 

1. Std iOS keypad 
2. Fixed special keys 
3. Selectable special keys 

  

Figure 1-1 Main Settings Window 

The Main Settings icon  is where most of the App features are configured.  
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 SITRANS CONNECTION Main Settings 2 
 

The Main Settings page is accessible via the  icon. This sets the application default 
settings for all sessions. Some of these defaults can be varied on individual saved 
connections (see Section 4 - Session Manager). 

The App settings cover 5 main areas: 

●  Terminal Settings – functions specific to the terminal window including: linewrap, local 
echo, scrollback size, and also access to the terminal scripting features. 

● Keyboard Settings – Settings for how the keyboard behaves (with or without external 
Bluetooth keyboard running). 

● Serial Settings – Settings specific to serial connections with the SITRANS flowmeter; 
baud rate, parity, data & stop bits. 

● SSH Settings – Features specific to “Secure Shell Connections” (i.e. certificates/keys and 
authentication methods). 

● Sharing Settings – Settings requiring configuration in order to share the iOS device 
terminal window with a remote user via the session server. 

The following section details each of these setting areas. 

2.1 Terminal Settings 

 
Figure 2-1 Terminal Settings 
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2.1.1 Columns (Default: 80) 
Supports any column width up to 132 characters wide. 

2.1.2 Rows (Default: 24) 
Supports any number of rows on the screen. 

2.1.3 Scrollback (Default: 100) 
Number of lines retained by the terminal for review. Setting this above 250 will impact 
performance on iPhone4 and below. iPad2, iPad3 and iPhone 4WS supports 500 scrollback 
without impact due to improved hardware specifications. 

2.1.4 Clear On Contact 
Defines whether the terminal should clear the screen when starting a new connection. 

The default is OFF 

Options: 
ON 
OFF 

2.1.5 LineWrap 
Defines whether the terminal should automatically wrap the line to the next line when the 
output received from the remote device exceeds the column width and no carriage return 
has been received. 

The default is ON 

Options: 
ON 
OFF 

2.1.6 Text Size 
Sets font size in the terminal window. 

Smaller................................................................Larger 

 
Figure 2-2 Adjusting Text Size 
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2.1.7 Console Logging (Default: Off) 
Logs all printable output to file stored on iOS device. The log files can be uploaded to 
Siemens SITRANS CONNECTION website, or extracted via iTunes. Typically this function is 
enabled when the user wishes to download a data file from the SITRANS flowmeter. Log 
upload is performed via the Files section described below. 

Options: 
ON 
OFF 

2.1.8 Auto Upload Logs (Default: Disabled) 
Automatically upload log files to remote storage repository (remote server) when the session 
finishes. Note that this feature will not operate if Wifi/3G connectivity is not available during 
the session. 

Options: 
Disabled 
Remote Server 

Note that to upload logs automatically to the remote server requires that the remote server 
username/password be configured in the main settings in order to be linked to the SITRANS 
CONNECTION App. 

2.1.9 Advanced Terminal Settings 

 
Figure 2-3 Advanced Settings 
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● Bell Behavior 
Allows the iOS device to create an alert when there is a Terminal event or stay silent. 

Options: 
Play Alert (bell/vibrate phone) 
Do Nothing (silent) 

● Cursor 
Allow the choice of cursor style – the default is Underline. 

Options: 

● None 

● Outline 

● Block 

● Vertical line 

● Underline 

● Blink Cursor 
Set cursor behavior – the default is Off 

● Color Scheme 
Changes the color scheme of the text and background of the terminal screen. 

 
Options:  
White on Black White text on Black background 
Black on White Black Text on White background 
Green on Black Green Text on Black background 
Rainbow Helps debugging by coloring different parts of the screen. 

• Blue: Left and right border 
• Red: Upper border of the scrollback limit 
• Black: Active area of the console within the scrollback limit 

● ANSI Color 
Allows up to 256 colors on terminal window following the ANSI spec for signaling color. The 
default is ON. 

Options: 
ON 
OFF 



 SITRANS CONNECTION Main Settings 
 2.1 Terminal Settings 

SITRANS CONNECTION APP 
Operating Instructions, 04/2014, A5E32182725-AC 15 

● Local Echo 
Controls whether the terminal will echo characters entered to the screen locally or rely on the 
SITRANS flowmeter to echo them. The default is Auto – where the terminal attempts to 
recognize if remote serial device is echoing characters, and if so disables local echo. The 
SITRANS flowmeter will echo typed characters therefore the default setting (Auto) is 
acceptable. 

Options: 

● Auto 

● Force On 

● Force Off 

● Term Environment 
Indication only, SITRANS CONNECTION is a VT100 terminal. 

● Scroll Mode 
Defines where the terminal view is positioned. For communication with SITRANS flowmeters 
the default setting of “Keyboard Input” is recommended. 

Options: 

● None - use touch screen to move around the terminal and scrollback window. 

● Keyboard Input (Default) - pressing any key on keyboard will return the window view to 
the active cursor position within the terminal window. 

● Terminal Activity – any terminal generated activity will center the terminal view to where 
the terminal activity is being generated. 

● Character Encoding 
SITRANS CONNECTION supports 17 different encoding formats. The default is UTF-8 
which is the required selection for serial communication with SITRANS flowmeters. 

● Paste Rate Limit 
When pasting large text files into the terminal window the remote serial device buffer or 
buffer memory inside the (C2-RJ45V) cable can overflow, producing garbled text. 

SITRANS CONNECTION has a speed control to allow for text from clipboard or scratchpads 
to be “fed” into the terminal at a slower speed to ensure that the receiving device and C2-
RJ45V cable do not overflow their receive buffers. 

Options: 

● Disabled (Text is sent to active terminal at maximum speed.) 

● Fast (Text is sent in 512 byte blocks with 1 second pause between blocks.) 

● Medium (Text is sent in 256 byte blocks with 1 second pause between blocks.) 

● Slow (Text is sent in 128 byte blocks with 1 second pause between blocks.) 
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2.2 Keyboard Settings 
There are 3 configuration items under the Keyboard Settings section of the main App 
Settings. 

 
Figure 2-4 Keyboard Settings 

 

 Note 

It is possible to use the SITRANS CONNECTION app with a Bluetooth keyboard and the 
settings configured here will have an effect on the keyboard. Further, full Bluetooth keyboard 
support is not yet implemented as ESC and arrow keys will not work on Bluetooth 
keyboards. 

 

2.2.1 Backspace Key 
The default setting is CTRL-H which is correct for SITRANS flowmeter communication. 

Options: 
Control-H 
Control-? (127) 

2.2.2 Enter Key 
SITRANS CONNECTION has 3 options for the command that will be sent when the enter 
key is pressed. By default it sends “Carriage Return” (0x0D) which is the OSX standard. This 
setting can be changed to Line Feed (0x0A) or both, Carriage Return followed by Line Feed 
(0x0D0A) each time the Enter key is pressed. For SITRANS flowmeters the default setting is 
correct. 

Options: 

● Carriage Return 

● Line Feed 

● CR + LF 
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2.2.3 Use Option as Ctrl 
SITRANS CONNECTION implements a workaround for the control key inoperability on 
Bluetooth keyboards. If using a Bluetooth keyboard with SITRANS CONNECTION, you can 
select the “Use Option as Ctrl” to use the Alt/Option key on the keyboard to send CTRL-[key] 
sequences. The default setting is OFF. 

Options: 
ON 
OFF 

2.3 Serial Settings 
The SITRANS CONNECTION serial settings allow for the full range of physical serial 
settings available on the C2-RJ45V cable to be set. When the C2-RJ45V cable is adapted to 
a DB9 connection, only the pins available on the RJ45V connector can be carried through; 
e.g. Pin 9 on DB9 connector (ring indicator) cannot be carried. This limitation does not affect 
communication with SITRANS flowmeters. 

The parameters available for each Serial option are described below: 

 
Figure 2-5 Serial Settings 

2.3.1 Auto Connect 
SITRANS CONNECTION App automatically connects to the physical cable connection (C2-
RJ45V or serial) when it’s plugged into the iPhone/iPad/iPod port. This applies whether or 
not there is an existing Telnet or SSH connection (a new Serial connection will be added to 
your connection list). 

Options: 
ON 
OFF 



SITRANS CONNECTION Main Settings  
2.3 Serial Settings 

 SITRANS CONNECTION APP 
18 Operating Instructions, 04/2014, A5E32182725-AC 

2.3.2 Baud Rate 
Allows the choice of different baud rates to suit communication with the SITRANS flowmeter. 
This setting must match the RS-232 configuration of the SITRANS flowmeter; failure to 
match the Baud rates will result in either no output or garbled screen output. The default 
Baud rates of the SITRANS flowmeter and the SITRANS CONNECTION App are 9600. The 
maximum baud rate for the SITRANS meters is 38400. It is recommended to set the 
SITRANS CONNECTION App and the SITRANS meter to 38400 for fastest communication 
of data. 

Options: 

● 1200 Baud 

● 2400 Baud 

● 4800 Baud 

● 9600 Baud 

● 19200 Baud 

● 38400 Baud 

● 57600 Baud 

● 115200 Baud 

2.3.3 Stop Bits (Default: 1 Stop Bit) 
1 stop bit is the standard configuration of the SITRANS flowmeter therefore this setting need 
not be changed. 

Options: 
1 Stop Bit 
2 Stop Bits 

2.3.4 Flow Control 
The default setting of Hardware RTS/CTS is suitable for communication with SITRANS 
flowmeters. If the flow control setting is changed the C2-RJ45V cable must be removed and 
reinserted to reset its configuration. 

Options: 

● None 

● Hardware (RTS/CTS) 

● Hardware (DSR/DTR) 

● Software (XON/XOFF) 
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2.3.5 Parity 
The default setting of all SITRANS flowmeters and the SITRANS CONNECTION App is 
“Odd”. This setting must match the RS-232 configuration of the SITRANS flowmeter; failure 
to match the parity will result in either no output or garbled screen output. 

Options: 

● Off 

● Odd 

● Even 

2.3.6 Data Bits 
The Data Bits selection default value is 7 in both the SITRANS Flowmeter and the SITRANS 
CONNECTION App. There should be no need to change this setting however if done it must 
be changed in both devices otherwise data transmission will not occur properly. 

Options: 
8 Bits 
7 Bits 

2.4 SSH Settings 
The SSH Settings section is used to determine the default authentication method when 
password authentication is used, and also allows for the import of “Open SSH” format 
certificates for use in SSH connections that use certificate based authentication. 

2.4.1 Keyboard Auth (SSH) 
Allows for interactive keyboard password authentication in addition to the usual SSL security. 
Not required for SITRANS flowmeter communication. The default method is OFF. 

Options: 
ON 
OFF 

2.4.2 Private Keys 
Allows for Private Keys to be imported and used in console sessions. Not required for 
SITRANS flowmeter communication. 

Options: 
Existing Key 
Import Key 
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2.5 Shared Settings 
SITRANS CONNECTION allows you to share your terminal window(s) with a remote private 
server monitored by Siemens technical support engineers. Each concurrent terminal session 
on the iOS device can be shared independently on the Siemens private server website, and 
made accessible via individual one-time token codes. The drawing below provides a simple 
overview of how the session sharing feature works: 

 

 
In order to enable session sharing, the “Sharing Sessions” details must be populated in the 
App settings. These requirements are preconfigured in the SITRANS CONNECTION App. 

 
Figure 2-6 Shared Settings 

2.5.1 Siemens SITRANS CONNECTION Server 
The remote Siemens private server is automatically configured in the iPhone / iPad for 
session sharing with the Siemens private server. The performance of the end to end terminal 
may vary dependent on the current load of the server and the latency of both the Apple 
device and the remote service engineer from the Siemens private server.  

2.5.2 Secure Connection (Default: Off) 
Use SSL for session sharing for more secure connections. When using a private server the 
SSL option should only be selected if the Private Server has a valid and publicly trusted (IE: 
trusted natively by iPhone / iPad) SSL certificate for the entered hostname. 
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Enabling SSL has a small impact on the remote performance. For maximum 
responsiveness; where encryption is not required, leave secure connection OFF. 

Options: 
ON 
OFF 

2.6 About SITRANS CONNECTION 

 
Figure 2-7 About SITRANS CONNECTION  

2.6.1 Version 
Version number of the SITRANS CONNECTION App. Updates to SITRANS CONNECTION 
occur automatically via the “App update process” in the iTunes App store. 

2.6.2 Copyright 
Year and holder of the copyright. SITRANS CONNECTION is a registered trademark owned 
by Siemens Industry Inc. 

2.6.3 About SITRANS CONNECTION 
About SITRANS CONNECTION App – displays version, copyright information, developers, 
LibSSH2 license and any other licenses for third party software that is incorporated into 
SITRANS CONNECTION. 
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 Configuring SITRANS Flowmeter to Communicate 
with SITRANS CONNECTION 3 
 

This section of the user guide will provide the instructions necessary to establish serial 
communication between an iPhone/iPad and a SITRANS clamp-on flowmeter. 

3.1 RS-232 Configuration 

3.1.1 iOS Device 
Access the settings menu in SITRANS CONNECTION as outlined in Section 2. Configure 
the serial settings to match the SITRANS flowmeter as listed and illustrated below. The Auto 
connect feature can be either on or off. These settings (Baud, parity, Data bits) must match 
the SITRANS flowmeter otherwise communication will not be established. 

 
Figure 3-1 Serial Settings 

 
Baud Rate: 38400 
Stop Bits: 1 
Flow Control: Hardware 
(RTS/CTS) 
Parity: Odd 
Data Bits: 7 

 



Configuring SITRANS Flowmeter to Communicate with SITRANS CONNECTION  
3.1 RS-232 Configuration 

 SITRANS CONNECTION APP 
24 Operating Instructions, 04/2014, A5E32182725-AC 

3.1.2 SITRANS Flowmeter 
1. Access the Meter Facilities/RS-232 Setup Menu. 

2. Verify the RS-232 settings shown below match the terminal settings of the SITRANS 
CONNECTION App shown in paragraph 3.1.2. 

3. For maximum speed set the RS-232 parameters in both the SITRANS meter and the 
SITRANS CONNECTION App as shown and illustrated below. 

 
Figure 3-2 RS-232 Setup 

 
Baud Rate: 
Parity: 
Data Bits: 
Line Feed: 
Network ID: 
RTS Key time: 

38400 
Odd 
7 
No 
0 
0.0 Secs 
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3.2 Cable Connections 

3.2.1 Cable Connection 
Refer to the table in paragraph 1.3 to determine the cable requirements for your specific 
SITRANS flowmeter type. For flowmeters equipped with an integral DB9 connector only the 
C2-RJ45V cable and the Null modem dongle are needed. For all other flowmeters use the 
appropriate connection kit listed in Table 1 (paragraph 1.3). This will ensure that you have 
the correct additional cable to connect with your meter type. Connect the C2-RJ45V cable to 
the iOS device and connect the flowmeter end (dongle or adaptor cable) to the SITRANS 
flowmeter RS-232 port. 

 
Figure 3-3 RS-232 Connection Points for meters without DB-9 
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 Launching Connections (Session Manager) 4 
 

With the “Auto Connect” feature enabled in the SITRANS CONNECTION settings menu the 
iOS device will immediately connect with the SITRANS flowmeter (providing the serial 
configurations of the two devices match as outlined above). 

4.1 Session Manager 
Alternatively a manual connection can be established by pressing the Connection icon   
 

This will launch the new connection “Session Manager” screen. SITRANS CONNECTION 
enables the user to simply elect to connect to the SITRANS flowmeter “manually” or to 
establish multiple configuration files if they plan to use different serial setups for different 
situations. They can then use the connection manager to launch a saved or recent (unsaved) 
connection configuration.  
To manually connect to the SITRANS flowmeter follow the steps below: 

 
① Tap the Connection icon 
② Tap the Connection Manager 
③ Tap the existing (saved or recent) connection or "New Connection" 
④ Name your connection and tap "Connect" 

Figure 4-1 Session Manager 

As can be seen in the sequence above each “connection” in the session manager can have 
its own specific name and communication options (i.e. baud rate, parity, scrollback, keyboard 
settings, etc.) which can be varied from the main settings default values via the session 
serial settings.  

In the figure below the Session Manager page shows the active session and also any 
recently closed sessions that can be restarted. Any live session (shown in blue) can be 
shared with a remote user by tapping the “Globe” icon. The session can be stopped by 
tapping the “eject” button. 
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If a session is stopped or times out, then it still remains visible in the Session Manager until it 
is deleted via the X button or is restarted via the restart button. See the figure below. 

 
① Eject icon to end 

session 
④ Reconnect icon 

② World icon for 
sharing session 

⑤ Delete icon 

③ Recently closed 
session 

⑥ Active session in blue 

Figure 4-2 Live Session and Live Session & Closed Session 

4.2 Quick Connect 

 
Figure 4-3 Quick Connect 
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Pressing the “+” button on the session 
manager page (as seen in the figure above) 
launches the Quick connect screen. This 
dialog allows for the instant launching of a 
new serial connection or launching an 
automatically saved recent connection. 
Depending on the type of connection, various 
session parameters (serial communication 
settings) will need to be completed to ensure 
compatibility before tapping the connect 
button. 

 

SITRANS CONNECTION can only maintain a 
single live Serial connection in the session 
manager as only one adaptor can be 
connected; however, it can store multiple 
instances of serial connections each with 
different session options (i.e. different baud 
rates) to make it easy to swap between serial 
connection templates. 
More detailed instruction for use of the 
connection manager including shared 
sessions can be found in Section 5 paragraph 
5.4. 
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 Communicating with SITRANS Flowmeter 5 
 

Once a connection between the iOS device and the SITRANS flowmeter has been 
established you have complete control of the flowmeter menu including the ability to fully 
program the meter, download datalogger, site and signal graph information, and act as a 
gateway for technical support through “sharing” of you session. This section will review the 
communication methodology, menu commands and file-download handling. When 
connected to the SITRANS flowmeter with SITRANS CONNECTION you are effectively in 
terminal mode; identical to utilizing Siemens “Si-Ware” program in terminal mode but from an 
iOS device instead of a PC!  

5.1 Initial Setup 

Setup Procedures 
The initial screen you will see once connected will be the “? For Help” response from the 
flowmeter (see figure below). If you tap the “Return” key this response will continue to occur 
each time and is indicative of a live connection.  

 
① Keyboard layout selection icon 
② Special Function Keys 

Figure 5-1 Initial Screen 

You may now choose to customize how the keypad is configured by tapping the left Keypad 
icon  to select one of its 3 options. (See figure above.) 
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Sequential tapping the icon will result in the 3 different modes as follows: 

1. No special keys 

2. Fixed special keys 

3. Programmable special keys: (indicated by a white bar above the key) 

The default custom screen as shown above is recommended since it provides the user with 
the 4 arrow keys necessary to navigate the flowmeter menu. 

 
Figure 5-2 Custom Key Selection 

If desired the function keys can be assigned other commands. To change a function-key 
assignment simply hold your finger on the icon until the command menu appears (see Figure 
5-2 at left) then tap the specific function you wish to assign. 
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Keypad Illumination 

In order to make full use of the limited iPhone screen size, SITRANS CONNECTION allows 
the terminal data to overlap the keypad display which enables viewing of the communication 
data while still providing access to the keypad. You can use the  button to control the 
onscreen iPhone keyboard. Sequential tapping of this icon will cause the keypad to display 
in the foreground, dim to the background (while remaining active), or hide completely. Hiding 
the keypad is used to increase screen real estate, especially useful with the iPhone smaller 
screen size. The dimmed background keypad allows full use of the limited screen size for 
viewing the SITRANS flowmeter menu while still enabling utilization of the keypad (see 
Figure 5-3). The brightness level of the keypad can be adjusted in the settings menu (see 
Figure 5-4). 

 
① Keypad in Foreground 
② Keypad n Background 
③ Full Screen Mode 

Figure 5-3 Keyboard Presence Settings 

 
Figure 5-4 Keypad Brightness 
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5.2 Navigating the SITRANS Menu 
When the “? For help” response is seen the user may simply type “menu<CR>” to gain 
access to the SITRANS flowmeter menu, they can then utilize the 4 directional arrow keys to 
navigate the menu just as with the meter’s keypad. The iOS screen will mimic the flowmeter 
display screen as you navigate through the menu. Programming of the flowmeter can be 
carried-out identically to utilizing the flowmeter keypad. Since programming fundamentals 
are well documented in the SITRANS “Quick Start” and “Operating Instructions" manuals, 
they will not be replicated in this manual. 

 

 Note 

If no menu navigation occurs for 30 continuous seconds the connection will time out. Simply 
type MENU again to re-establish communication. This time period can be extended by typing 
“menu_N” with “N” representing the number of seconds before time out (e.g. menu 1000)  

 

 

 
① Main Menu Screen ③ Custom Keypad Selected 
② iOS keypad in 

background for 
better viewing of 
serial data overlay 

④ Menu Navigation Arrow Keys 

Figure 5-5 Main Menu Screen 

Menu Commands 

Navigating the SITRANS menu, programming the meter, and downloading data can be 
performed with relatively few commands. The table below highlights the most commonly 
used functions and command sequences. Downloading commands will be covered later in 
this section. 
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Command Function 

  Arrow keys move menu cursor one step in the direction indicated 
Menu<CR> Command gives access to meter menu from a blank or initial screen 
<Ctrl>L Hold CTRL key and type “L” to switch from flow display to menu 

 <CR> Return key acts as “Enter” key when programming 
 Backspace Backspace key acts as “CLR” key to clear a menu cell 

Logger <CR> Type "Logger <CR>" to force download of datalogger content or use 
"Logger" hotkey 

Site (N) <CR> Forces download of site programming data. (N) = channel number 
DP_(N) <CR> Forces download of signal graph data. (N) = channel numbers section 

5.3 Downloading Data Files (Console Logging) 
A frequently used capability of serial communication with SITRANS flowmeters is the ability 
to download and save data files. Files available for downloading include the datalogger, the 
site programming data, and the sensor signal graph. Instructions for capturing these data 
files to your iOS device appear in the following paragraphs. 

5.3.1 Console Logging 
The user has the option to log all screen activity when communicating with the SITRANS 
flowmeter, doing so will automatically create a log file and capture every keystroke. Logging 
in this fashion would be considered “Session Logging”. This ability can be initiated from the 
“Console Logging (On/Off) control in the Settings menu. Additionally, the created file can 
then be accessed in the "Logging" tab of the Tools menu. SITRANS CONNECTION will 
automatically create logging file names with the following convention:  

 

Console_YYYY-MM-DD_HHMMSS.txt 
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5.3.2 Downloading Files 
In lieu of logging all SITRANS CONNECTION activity, the user may find it more beneficial to 
log only specific data, notably files selected for download; for example the SITRANS 
datalogger. The user can therefore opt to start and stop logging manually, this can be 
accomplished in the SITRANS CONNECTION "Logging" tab of the Tools menu by tapping 
the "Start Logging" button, then initiate your download. Doing so will create individual files for 
each download and use the same naming convention illustrated above. When download is 
complete return to Logging tab and tap the current active file name (indicated by a green 
dot). Tap "Stop Logging" to close file. 

 
① Tools Menu 
② Logging Initiate Button 
③ Saved Log Files 

Figure 5-6 Downloading Files 

 

 Note 

The above image represents the iPhone screen; iPads do not have a Tools icon but rather 
individual icons representing each of the available functions. 
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5.3.3 Viewing/Using Data Files 
Individual console log files can be viewed locally on the iOS device screen, uploaded to the 
shared server or e-mailed. The ability is controlled in the Logging tab of the Tools menu. 
When in the Logging screen tap the file name you wish to utilize in the File Menu (see figure 
below). This action opens up a pop-up, File Control Options, which gives access to a variety 
of possible actions (see figure below). 

● Delete the file 

● Delete All Files 

● Copy to Clipboard (for viewing on iOS device screen) 

● Upload to Website (shared server) 

● Send via e-mail 

 
① File Menu 
② File Control Options 

Figure 5-7 File Menu and File Control Options 

If it is desired to view the data on the iOS screen select "Copy to Clipboard" and the data will 
automatically display in the clipboard editor which can be used to edit the text, save it as a 
new file name, or just simply for viewing locally (see figure below). 
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Figure 5-8 Clipboard Editor 

● To e-mail the file to yourself or another person, tap the "send via Email" button. This will 
automatically open your iOS e-mail with the file attached. 

● To upload the file to the shared server system, simply select "Upload to Website" and the 
transfer will occur automatically. 

● You can also choose to delete the current file or delete all files if desired. 

5.4 Connection Manager 
As previously discussed, the connection manager is used to create, modify and launch 
saved connections. Tapping connection manager in the session manager screen will launch 
connection manager where all saved connections can be administered. 
Creating new connections can be done one of 2 ways: 

1. Via the connection manager “New Connection” dialog box (discussed in this section). 

2. By converting a recent “quick connection” to a saved connection via the blue arrow (give 
the recent connection a description and then tap save). 
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5.4.1 Serial 
For making serial connections via the C2-RJ45V cable. The following parameters can be 
configured on a per session basis, all other serial settings are inherited from the Main 
Settings defaults: 

 
Figure 5-9 Connection Details 

 
Description: Define a name for this connection. 
Serial Settings: The baud rate, stop bits, flow control, parity and data bits can be set 
on a per connection basis. All other settings are globally configured in the Main 
Settings page. 
Terminal Settings: Like all other connections, the terminal settings defines all non-
default terminal characteristics for this specific connection. 
Keyboard Settings: Like all other connections, the Keyboard settings can override the 
default Keyboard settings on a per connection basis. 
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5.4.2 Managing Connections in Folders 
Connection manager allows for the creation of connections, grouping of connections into 
subfolders and also for cloning connections and moving them between subfolders. These 
folders are stored in the SITRANS CONNECTION application’s file system area within the 
iPhone/iPad. 
● Creating and managing folders and sub-folders for connections 

 
Figure 5-10 Create Folder 

Tap “New Folder” to create a new folder and enter name in dialog box. The folder appears at 
the top of the saved connections list. Folders can be nested, so to create a subfolder; 
navigate to the newly created folder by tapping it, then tap the “New Folder” button again. 

Saved connections can be moved from one folder to another or to the root. To move a 
connection tap the blue arrow next to a saved connection, scroll to the bottom where there 
are options to Move (to a) Folder, Clone the Connection or Delete. 

 
① Tap the blue arrow next to a connection 
② Then scroll to the bottom of the screen to choose an option 

Figure 5-11 File and Folder Management 
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A sub-folder can also be created under another folder with connections in it. Note that if you 
delete a folder which contains a connection, the connection will be moved to the root folder 
instead of being deleted together with the folder.  

● Recent Connections 

The SITRANS CONNECTION App connection manager presents the 10 most recent 
connections in the saved connections area. The connections listed in recent connections 
include quick connections and saved connections. This list can be cleared by tapping the 
“clear recent connections” button at the very bottom of the list. Alternatively, a recent 
connection that was made with the “quick connect” method can be saved to the connection 
manager by tapping the blue arrow, providing a name (description) for the connection and 
then tapping save. The connection will then appear in the root saved connections folder of 
the connection manager. 

5.5 In Session Options 
Once a connection has been established (or attempted to be established) it will appear in the 
session manager. From this popup the actions that can be performed depend on whether the 
connection is live (connected - Blue) or closed (disconnected - red). 

 
Figure 5-12 Session Options 

 

  Session Options: Allows for editing of changeable settings while the session is live. For 
example, changing the terminal width, scrollback, color scheme, etc. 

 Share Session: Will share the terminal screen with the configured remote server (Public or 
Private), and generate a one-time token code. See the session sharing Settings (paragraph 
3.5 above) and how to operation below. This icon may be place with the special function 
keys on the iPhone screen for 1-touch sharing. 

  Disconnect Session: Disconnect from the serial cable connection. The session will stay 
visible in the session manager list of sessions with the 2 options below remaining available. 

  Restart Disconnected Session: Attempts to reconnect the session to the SITRANS flowmeter 
using the serial cable connection. 

  Delete: Remove Disconnected Session from Session Manager 
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5.6 Session Sharing 

5.6.1 Session Sharing 

 
Figure 5-13 Shared Session Notification and Token Code 

● Tapping the icon will attempt to automatically share the selected terminal session with 
the Siemens private server to enable a remote technical support engineer to see and 
interact with the terminal session at the same time. In order to use this feature the 
settings for session sharing must be configured in the Main Settings page (see Section 
2). 

● Each shared terminal session is dynamically given a one-time token (session) code at the 
time session sharing is initiated. This code is used to secure access to the users 
iPad/iPhone and appears automatically in the Siemens private console where the 
Siemens technical support engineer will have access to it. Additionally the 7-digit token 
code is published for the user in case there is a need for it. 

● Only sessions that are shared are visible to technical support. 
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5.6.2 Establishing a Tech Support Session 
If the user requires technical assistance with their SITRANS flowmeter contact should first be 
established with the nearest tech support center by phone. 

● For support in the USA call: 1-800-333-7421 

The call center will log your request and application information and establish a service ticket 
number. A qualified service engineer will respond directly to the user. At that time the shared 
iOS session can initiate. 

Sharing the Serial Connection 
Once the notification “You are sharing your terminal” appears, the remote support engineer 
can access the iOS device using the token code displayed in the notification. If the session 
code is unavailable to the service engineer for any reason the code can be emailed or 
copied to clipboard via this notification window. 

Table 5- 1 Shared Session Options 

Options Function 
OK Return to the active terminal window. 

Copy Copy the remote access token code to the clipboard so that it can be used in text 
message or other iOS device message 

Email Email the remote access token code to a recipient with instructions how to connect to 
the shared session. 

Once shared, the token code will also appear in the Session Manager, and the Globe icon 
will show green. 

 
Figure 5-14 Session Token Code 
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5.6.3 Remote User Access 
Remote access to shared terminal sessions is made via the Siemens privately hosted server 
by a qualified SITRANS technical support engineer. When a session is shared the engineer 
will have access to it in the Siemens private console server and can simply click the code to 
directly connect to the shared session.  

Both iPad/iPhone user and support engineer can interact with the terminal session at the 
same time. Note that the support engineer can only interact with the terminal while the 
SITRANS CONNECTION App is in the foreground on the iPad/iPhone. If SITRANS 
CONNECTION is in the background, it will still maintain its Serial session for up to 10 
minutes, however the engineer will not be able to interact with the session until SITRANS 
CONNECTION is brought to the iPad/iPhone foreground again. 

5.6.4 Stop Sharing Session 

To stop sharing an iPad/iPhone terminal session with a support engineer, tap the  button 
to activate the Session Manager icon overlay, then tap the green Globe icon for the 
terminal tab that sharing should be disconnected. The Globe icon will turn grey and the 
subtitle will change from the token code to say [Not Shared]. 
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 Troubleshooting 6 
 

This section covers common problems reported by users, typical fixes and work arounds. 

6.1 Serial Connectivity Issues 
Serial connectivity issues can be divided into 2 types: 

● Where SITRANS CONNECTION cannot recognize / communicate with C2-RJ45V cable 

● Where SITRANS CONNECTION can recognize C2-RJ45V cable, but no cannot 
communicate with the SITRANS flowmeter (no menu data on screen) 

6.1.1 C2-RJ45V Cable Pinouts 
The following drawing shows the standard C2-RJ45V cable pins and what serial signal they 
send, and also the corresponding pins when the C2-RJ45V-to-DB9 adaptor is used. 

 
Figure 6-1 C2-RJ45V Cable Pinouts 

6.1.2 Console Cable Not Detected 
If this error is seen and there is a cable plugged into the iOS device, then check that the iOS 
device is detecting the cable by going to the iOS devices general settings -> about -> 
console cable. This will show the cable hardware and firmware detected. SITRANS 
CONNECTION only works with the C2-RJ45V cable. If you have a C2-RJ45V cable 
connected but it is not detected by the apple iOS operating system; check that it is seated 
correctly and/or reinstall the SITRANS CONNECTION App. 
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6.1.3 Cable detected but no communication 
If the cable is detected but no output appears on the screen, the most common reasons are: 

● Baud Rate mismatch – note that the SITRANS flowmeter and the SITRANS 
CONNECTION App must both utilize the same baud rate setting. SITRANS flowmeters 
do not support baud rates above 38400. 

● Flow control is required - by default it is RTS/CTS. Note disconnect cable from both 
iPad/iPhone and SITRANS meter after changing Flow Control to reset cable. 

● Dongle type – SITRANS meters having an onboard DB-9 connector require the use of the 
“Null Modem” DB-9 Dongle (Brown). This reverses the Tx/Rx connections of the C2-
RJ45V cable and permits proper communication. If the SITRANS meter in use requires 
an interconnection cable between the C2-RJ45V cable and the flowmeter (all non-DB-9 
connections) the Standard dongle (Black) must be used otherwise the null modem 
connection will be defeated. Both dongle types are included in the SITRANS 
CONNECTION App connection kit, be sure to use the proper dongle for your meter. 

● Cable needs to be reset – the C2-RJ45V cable has active electronics in it. Occasionally it 
needs to be reset by removing BOTH ends of the cable from iPhone/iPad and SITRANS 
flowmeter, and then reconnecting it first to the flowmeter device end. 

● Meter Reset – It is not uncommon when changes are made to the settings in SITRANS 
CONNECTION, or if the App is accidentally switched off, that communication with the 
flowmeter cannot be re-established. Turn the meter off and back on again to re-establish 
communication. 

● Time-Out – If communication between SITRANS CONNECTION App and the SITRANS 
flowmeter is inactive for more than 30 seconds (no commands sent), the App screen will 
go blank. Type "menu” to reconnect with the flowmeter and continue your session. The 
time-out period can be lengthened by typing “menu_N” with N = number of seconds. 

6.2 Session Sharing Issues 
If Session Sharing to the Siemens console server fails or if a “Failed to connect / read from 
remote control server” message is observed:  

● Check your internet connection (can you browse in mobile safari to an internet page?) 

● Check Session Sharing settings configurations defined in Main Settings -> Session 
Sharing are correct (see Section 5.6). 

●  If everything is correctly configured, try again – depending on latency the first attempt to 
connect can fail due to the underlying encryption key exchange taking too long. 

● If having problems with the Siemens server contact the server administrator. 
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